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Inleiding 
 
Het Technisch Tekenen met AutoCad-software heeft in het bedrijfsleven nagenoeg 
alle handmatig tekenen verdrongen. Het is dan ook logisch dat studenten tijdens 
hun opleiding kennismaken met de mogelijkheden van AutoCAD. In deze 
introduktie tot het in 2D  tekenen met Autocad-software leren de studenten o.a.:  

o een bestand openen en sluiten  
o tekenen van lijnen, cirkels, veelhoeken binnen een raster  
o aanbrengen van lijndikte, lijnsoorten, arcering en tekst  
o werken met lagen 
o objecten verplaatsen, kopieren, verschalen, roteren 
o vermaten 
o objecten uit een bibliotheek halen 

 
Na deze algemene kennismaking dient de student in staat te zijn vakgericht te 
kunnen tekenen met AutoCad-software om een complete werktekening te maken. 
 
 
 
Ing. A. M. Plein 
aplein@hotmail.com 
November 2004 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Niets uit deze uitgave mag worden verveelvoudigd, of openbaar worden gemaakt, 
in enige vorm of op enige wijze, hetzij electronisch, door fotokopieen of op ander 
wijze, zonder voorafgaande schriftelijke toestemming van de auteur. 
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Introduktie AutoCad (2D) 
AutoCad is het meest populaire C(omputer) A(ided) D(esign) programma 
hedendage.  
 

1. Starten met AutoCad 
Verschillende manieren om Acad op te starten 

1. Via een snelkoppeling op het buroblad 
2. Via de startknop in Windows 

1.1. Het scherm 

 
1: Hier zie je wat je tekent uiteraard 
2: Je muiscursor ziet er iets anders uit dan je gewend bent. 
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3: Onder deze tab zit alles wat je tekent. 
4: Onder deze tab(s) zit alles wat je wil printen.  
5: Je tekent op lagen. Bijvoorbeeld remsporen op laag "sporen"etc.  
6: De commandoregel is enorm belangrijk, want voor alles wat je doet in AutoCad 
is er wel een commando. Het moet een soort van tweede gewoonte worden om 
alles wat er op de commandoregel gebeurt te lezen. 
7: Links zie je coordinaten, rechts kan je standaardinstellingen veranderen. 
8: Alles wat je doet is 3D, echter vaak is de z-coordinaat 0 (je werkt dan 2D).  

1.2. Een nieuwe tekening beginnen 
Als AutoCad opstart dien je de tekengrenzen (Drawing Limits) en de teken 
eenheden (Drawing Units) vast te leggen.  

1.2.1. Tekengrenzen (Drawing Limits) 

De tekengrenzen worden bepaald door de hoofdafmetingen van je voorwerp. 
In de menu bar, kies Format → Drawing limits. Tik in op de commandoregel: 

- Lower left corner : 0,0 <enter> 
- Upper Right corner: 297, 210 <enter> 

Als tekengrens heb je net het liggend formaat van een A4 ingevoerd. 

1.2.2. Teken eenheden (Drawing Units) 

In de menu bar, kies Format → Units. Voer de onderstaande waarden in.  

 
Opmerking: 
Als AutoCad opstart kun je ook de bovenstaande instellingen vastleggen met de 
start up Wizard, Advanced Setup. 
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1.3. Toolbars 
In het scherm bevinden zich de toolbars, dit zijn knoppenbalken waarmee 
commando’s kunnen geactiveerd. AutoCad geeft de mogelijkheid om diverse 
toolbars op je scherm weer te geven. De bovenstaande toolbars worden op je 
scherm geplaatst door in de menu bar, kies View→ Toolbars. Selecteer de Draw, 
Modify, Object properties en Standard toolbars. Sleep de toolbars naar de locaties 
zoals boven. 

1.4. Commandovenster 
In het commandovenster staan commandoregels weergegeven. 
De commandoregels hebben twee functies: 

1. Via de commandoregel kunnen commando’s worden ingevoerd. 
a. Bijv. het commando ‘zoom’ wordt ingevoerd 
b. Voor een heleboel commando’s hoeft slechts de beginletter ingevoerd te 

worden. Bijv. z is een afkorting voor het zoom commando. (Ga naar 
verkenner/explorer en zoek het bestand acad.pgp. Lees welke afkortingen 
gehanteerd kunnen worden). 

2. In het commandovenster komen mededelingen van het programma over 
actieve commando’s te staan. 
Opmerking:  
a. Wat tussen chevrons <> staat is de standaardwaarde (dfault value) of de 

laatst ingevoerde waarde.   
b. Wat tussen rechte haken [ ] staat zijn de opties die het commando biedt. 

1.5. Muis functies 
Muisknop Naam Doel 
Links Selectieknop Het selecteren van 

-Menu Opties 
- Het defenieren van een 
punt in de tekening (b.v. 
begin- of eindpunt van 
een lijn) 

Midden of shift + 
rechtermuisknop 

Osnap menu Het selecteren van Object 
snaps uit een cursormenu 

Rechts  Enter knop - het bevestigen van een 
vraag 
- Het afsluiten van een 
commando 
- Het heractiveren van 
een commando 
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Opmerking: 
De enter knop, de spatiebalk en de rechter muisknop hebben dezelfde functie. 

1.6. Je eerste pennestreek 
Tik in line <enter>  
Beantwoord de volgende vragen op de commandoregel met achtereenvolgens 0,0  
<enter> 
10,0<enter> 
10,10<enter> 
0,10<enter> 
c<enter> 
 
Tik in circle<enter> 
5,5<enter> 
5<enter>  
 
Tik in zoom<enter> 
e<enter> 
z<enter> 
0.7x<enter> 
 
Tik in regen<enter> 
 
Druk op F2 om nog eens goed te kijken wat je hebt gedaan. 
 
Laten we eens een paar dingen bekijken: 
- Specify next point or [Close/Undo]: c Hier gebruikte je een optie, namelijk c van 

Close. Bedenk dat je ook had kunnen invoeren 0,0 en dat dat in dit geval op 
hetzelfde zou zijn neergekomen.  

- Doe nog eens circle;0,0; 
CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 0,0 
Specify radius of circle or [Diameter] <5.0000>: 
Als je nu een <enter> geeft dan accepteert AutoCad de standaardwaarde 
(default value) van 5 (de laatst ingevoerde waarde)  

1.7. Erase 
Voordat we verdergaan is het belangrijk om te weten hoe je elementen kunt 
verwijderen uit je tekenveld. Met het commando erase kun je objecten 
verwijderen. Je kunt elk element stuk voor stuk selecteren (toevoegen door shift 
ingedrukt te houden) of je kunt gebruikmaken van window, crossing selectie. Je 
hebt dan 2 punten nodig. niet slepen maar punt 1 aanklikken (en loslaten) en punt 
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2 aanklikken (en uiteraard ook weer loslaten). Van links naar rechts is Window 
selectie (alles wat in het venster valt).  Van rechts naar links is Crossing selectie 
(alles wat in het venster valt + alles wat er doorheen steekt).  

1.8. Coordinaten opgeven 
 

Poolcoordinaten: 
De richting van de hoek wordt bepaald door de 
ingesloten hoek tussen de lijn en de horizontale 
as door het punt 

 

 

 

 

Diverse notaties:  

1. Absolute coordinaten invoer: x,y → afstand t.o.v. het nulpunt (0,0) 
2. Relatieve coordinaten invoer @x,y → afstand t.o.v. het vorig punt  
3. (Relatieve) poolcoordinaten invoer: @lengte<hoek x-as (bijvoorbeeld 5<45)  
4. Directe invoer: ortho aan, richting met de muis, lengte intoetsen 

Oefening 
 
 
 

Punt Abs. 
Coord. 

Rel. Coord. Rel. 
Poolcoord. 

Dir.inv. 
(ortho) 

A 5,5 5,5 5,5 5,5 
B 72,5 @67,0 @67<0 → 67 
C 72,93 @0,88 @88<90 ↑ 88 
D 51,93 @-21,0 @21<180 ← 21 
E 51,144 @0,51 @51<90 ↑ 51 
F 14,144 @-37,0 @37<180 ← 37 
G 14,35 @0,-109 @109<270 ↓ 109 
H 5,35 @-9,0 @9<180 ← 9 
A Close Close Close Close 

C 
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2. Basics... 
 

2.1. Tekenhulpen 
Om het tekenwerk te vergemakkelijken en om de tekenkwaliteit te verhogen zijn er 
een aantal tekenhulpen in AutoCad beschikbaar. 
 
Enkele tekenhulpen zijn: 

a. Het Helpmenu 
b. SNAP en GRID mode 
c. ORTHO mode 
d. Vangfuncties (OSNAP) 

2.1.1. Het Helpmenu 

Tijdens het werken in AutoCad kun je op ieder moment hulp opvragen. Het 
helpmenu geeft informatie over de werking van een bepaald commando. Met een 
druk op F1 verschijn het helpmenu in het venster. 

2.1.2. SNAP en GRID 

Deze hulpfunkties zijn een van de standaardinstellingen midden onderin je scherm. 
Ze kunnen ook aan- of uitgemaakt worden met het toetsenbord. 
SNAP → F9; GRID → F7 
 
Oefening SNAP en GRID instellen 

1. In de menu bar, kies Tools → Drafting settings.  
2. Toets voor Snap X spacing de waarde 20 in 
3. Toets voor Snap Y spacing de waarde 20 
4. Doe hetzelfde voor GRID 
5. Select SNAP ON 
6. Select GRID ON  
7. Klik OK  

 
Bij het bewegen van de muis zien we dat de kruisdraden met sprongen van 20 over 
het beeldscherm gaan en de afstand tussen de rasterpunten bedraagt eveneens 
20. Let hierbij ook op de coordinatenaanduiding in de statusbalk, die een veelvoud 
van 20 aangeeft.  
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2.1.3. ORTHO 

Met ORTHO kunnen we lijnen tekenen die loodrecht staan in horizontale en 
verticale richting. ORTHO kan ook aan- of uitgemaakt worden met het toetsenbord. 
ORTHO → F8 
 
Oefening 
Teken de figuur zoals hieronder is beschreven 

1. Schakel Snap in (F9) 
2. Schakel Grid in (F7) 
3. Schakel Ortho in (F8) 
4. Teken via het line commando en met behulp van het aanwijsapparaat, dus 

zonder het toetsenbord te gebruiken, een vierkant met een zijde van 200. 
5. Trek de twee diagonalen (uitschakelen Ortho!) 
6. Plaats op het snijpunt van de diagonalen een cirkel met een radius van 100 

2.2. Vangfuncties (OSNAP) 
Om 100% nauwkeurig te kunnen tekenen hebben we de beschikking over een 
aantal tekenhulpen die vangfuncties oftewel OSNAP worden genoemd. Met de 
vangfuncties heb je de mogelijkheid een bepaald punt ‘ongeveer’ te localiseren, 
terwijl Autocad de exacte bijbehorende coordinaten erbij zoekt.  
 
In de menu bar, kies Tools → Drafting settings. Selecteer de onderstaande velden. 
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2.2.1. Snap to Endpoint 

Snapt naar het eindpoint van een lijn of boog, waar de cursor het dichtste bij zit. 

2.2.2. Snap to Midpoint 

Snapt naar het midden van een lijn of boog. 

2.2.3. Snap to Intersection 

Snapt naar het kruis- of snijpunt van twee objecten. 

2.2.4. Snap to Center 

Snapt naar het centerpunt van ronde objecten als bogen en cirkels. 

2.2.5. Snap to Tangent 

Rakend aan een cirkelvorm. 

2.2.6. Snap to Perpendicular 

Snapt naar een punt op een object via een loodrechte weg. 

Oefening  
1. Teken een verticale lijn met beginpunt (350,53.7) en eindpunt (350,217.4) 
2. Teken een cirkel met het center op (66,77) en een radius van 52.5 
3. Teken lijn a 

- Beweeg de cursor op de omtrek van de cirkel tot het ‘Center’ symbool 
oplicht (een rondje in het hart van de cirkel). Klik met je muisknop om te 
bevestigen dat het beginpunt van de lijn ligt in het hart van de cirkel. 

- Plaats de cursor op de verticale lijn tot het ‘Perpendicular’ symbool oplicht. 
Klik met je muisknop om te bevestigen dat het eindpunt van de lijn ligt 
loodrecht op de verticale lijn. 

4. Teken lijn b 
- Het beginpunt van de lijn ligt in het hart van de cirkel. 
- Plaats de cursor op de verticale lijn tot het ‘Midpoint’ symbool oplicht. Klik 

met je muisknop om te bevestigen dat het eindpunt van de lijn ligt in het 
midden van de verticale lijn. 

5. Teken lijn c  
- Beweeg de cursor op de omtrek van de cirkel tot het ‘Tangent’ symbool 

oplicht. Klik met je muisknop om te bevestigen dat het beginpunt van de 
lijn ligt rakend aan de cirkel. 
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- Plaats de cursor op de verticale lijn tot het ‘Endpoint’ symbool oplicht. Klik 
met je muisknop om te bevestigen dat het eindpunt van de lijn ligt op het 
eindpunt van de verticale lijn. 

 

2.3. Zoom commando's 
Hieronder vind je de belangrijkste zoom-commando's.  

• Zoomen kan transparant, wat wil zeggen dat zoom commando's binnen 
andere commando's gebruikt kunnen worden. Toets in ‘-z of ‘-zoom. Benut 
dat!  

2.3.1. Zoom In 

Het beeld vergroten om details beter te kunnen bekijken. Typ in factor >1 

2.3.2. Zoom In  out 

Het beeld verkleinen om een beter overzicht van de tekening te hebben. Typ in 
factor <1 

2.3.3. Zoom Window 

Deze optie geeft een vergroting van het getekende te zien, dat gevangen is in 
een kader (=window) 

2.3.4. Zoom Previous 

Hiermee krijg je de voorlaatste zoom-situatie terug op het scherm 

2.3.5. Zoom Extents 

Deze optie gebruik je om het getekende zo groot mogelijk op het scherm te zien 
verschijnen. 

2.3.6. Zoom All 

Deze optie geeft de gehele tekening weer op het scherm, mits alle 
tekenelementen binnen de tekengrenzen vallen. Zijn er tekenelementen buiten 
de tekengrenzen terechtgekomen, dan komen deze ook op het scherm.  
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2.3.7. Zoom Realtime 

Met zoom realtime kan je dynamisch zoomen. Door de muis van boven naar 
beneden, of van beneden naar boven te bwegen, terwijl de linkermuisknop blijft 
ingedrukt, wordt het getekende verkleind of vergroot. 

3. Tekenen van elementen 
 

3.1.  Line: L; 
Hiermee teken je uiteraard lijnen. Vergeet de opties niet! (c=close, u=undo van 
laatst getekende segmentje)  

3.2.  Circle: C; 
Cirkels kunnen op de volgende manieren getekend worden 

1. Een middelpunt en een radius invoeren 
2. Twee punten die de diameter bepalen 
3. Drie punten die de omtrek bepalen 
4. Twee raakpunten en een radius 

 
Oefening 

1. Teken een cirkel waarvan het middelpunt ligt op het coordinaat (200,150) 
met een diameter van 120 
Uitwerking 
a.) Tik in circle 
b.) Command : Specify center point for circle or [3P. 2P/ Ttr (Tan tan 

radius)]:200,15 <enter> 
c.) Specify radius of circle or [Diameter]: 60 <enter> 
d.) Command: 

2. Teken een cirkel met middelpunt (260,150) en een radius van 120 
3. Teken een cirkel waarvan de diameter bepaald wordt door twee punten. Deze 

punten liggen op de coordinaten (260,150) en (380,150). Gebruik hiervoor 
de 2P optie. 

4. Teken een cirkel waarvan de diameter bepaald wordt door twee punten. Deze 
punten liggen op de coordinaten (250,150), (310,260) en (380,150). Gebruik 
hiervoor de 3P optie. 

5. Teken twee lijnen: van de coordinaten (200,200) naar (200,100) en van 
(200,100) naar (300,100). Teken een cirkel die tangent is aan deze twee 
lijnen met een radius van 50. Gebruik hiervoor de Ttr optie. 
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3.3.  Arc: A 
Cirkelbogen kunnen op verschillende manieren worden getekend. 
- Het opgeven van drie punten, een beginpunt, een tweede punt op de boog en 

een eindpunt.  
- Het opgeven van een beginpunt, een eindpunt en een ingesloten hoek. 

 
Binnen Acad worden cirkelbogen standaard tegen de wijzer van de klok 
ingetekend. 
 
Oefening 

1. Teken een cirkelboog die gaat door de punten (150,100), (225,175) en 
(150,250) 

a. Tik in arc 
b. Command : Specify start point of arc or [Center]:150,100 <enter> 
c. Specify second point of arc or [Center/ End]:225,175<enter> 
d. Specify end point of arc: 150,250 
e. Command: 

 
2. Teken een cirkelboog met als startpunt (150,100), als eindpunt (150,250) en 

de ingesloten hoek is 270 graden 

3.4.  Ellipse: EL 
Een ellips kan getekend worden door de eindpunten van de twee assen vast te 
leggen. 
 
Oefening 

1. Teken een ellipse boog zoals hieronder beschreven 
a. Tik in ellipse 
b. Command : Specify axis endpoint of ellipse or [Arc/ Center]: a <enter> 
c. Specify axis endpoint of elliptical arc or [Center]: 80,150 <enter> 
d. Specify other endpoint of axis: 320,150 <enter> 
e. Specify distance to other axis or [Rotation]: 200,290 <enter> 
f. Specify start angle or [Parameter]: 60,150 <enter> 
g. Specify end angle or [Parameter/ Included Angle]: 340,150 <enter> 
h. Command: 

 
2. Teken een ellipse waarvan de eindpunten van de horizontale as liggen op de 

coordinaten (80,150) en (320,150). Het eindpunt van de as die hier 
loodrecht op staat ligt op (200,80)   
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3.5.  Polygon: POL; 
Met dit commando kun je regelmatige veelhoeken tekenen met n-kanten. Voer 
eerst het aantal zijden in. Vervolgens kiezen tussen optie: 
- Edge: Het opgeven van de lengte van een zijde 
- Circumscribed: het opgeven van de radius van de denkbeeldige cirkel in de 

veelhoek 
- Inscribed: het opgeven van de radius van de denkbeeldige cirkel om de 

veelhoek 
 
Oefening 
 

1. Teken een regelmatige achthoek om een denkbeeldige cirkel met een radius 
van 100, waarvan het middelpunt ligt op het coordinaat (250,150).  
Uitwerking 

a.) Tik in polygon 
b.) Command : Enter number of sides<4>:8 <enter>  
c.) Specify center of polygon or [Edge]: 250,150 <enter> 
d.) Enter an option [Inscribed in circle/ Circumscribed about circle]<I>:  

C<enter> 
e.) Specify radius of circle: 100 <enter> 
f.) Command: 

 
2. Teken een regelmatige vierhoek waarvan de zijde een lengte heeft van 

141.42. Gebruik hiervoor de Edge optie. Het begin van een zijde ligt op de 
coordinaten (179.29,79.29) 

 
 

4. Tekst 
Op twee manieren kan tekst toegevoegd worden aan een tekening. Gaat het om 
relatief weinig tekst, dan gebruiken we ‘Single line text’. Gaat het om veel tekst, 
dan kun je ‘Multiline text’ gebruiken.  

Met de optie ‘Specify start point of text or [Justify/ Style] kun je bepalen hoe de 
tekst geplaatst gaat worden. Toets je een ‘J’ van Justify in, dan kun je een keuze 
maken uit de volgende mogelijkheden 

- Startpoint Tekst uitgelijnd vanaf het beginpunt 
- Align  Tekst uitgelijnd tussen twee punten, teksthoogte is  

afhankelijk van tekstlengte 
- Fit  Tekst uitgelijnd tussen twee punten, teksthoogte is  
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onafhankelijk van tekstlengte 
- Middle Tekst uitgelijnd vanuit het hart 
- Center Tekst uitgelijnd vanuit het midden van de basislijn 
- Right  Tekst uitgelijnd aan de rechterkant 

 
Met de optie ‘Specify start point of text or [Justify/ Style] kun je ook bepalen welke 
tekststijl van toepassing is. Toets je een ‘S’ van Style in, dan kun je een andere 
tekststijl selecteren. De nieuwe tekststijl moet je wel eerst definieren met FORMAT 
→ TEXT STYLE. 
 
Bijzonder tekst symbolen 

- %%o  Aan- en uitschakelen lijn boven een tekst 
- %%u  Aan- en uitschakelen lijn onder een tekst 
- %%d  Graden teken 
- %%p  Plus-min teken 
- %%c  Diameter symbool 

 
Oefening 
 

1. Schrijf met behulp van ‘Single line text’ je voor- en achternaam met een 
letterhoogte van 10.  

 
Uitwerking: specificeer startpunt → specificeer teksthoogte: 10 → specificeer 
rotatie hoek:0   → specificeer tekst:CAD 

 
2. Plaats over een lengte van 100 en met een letterhoogte van 50 de 

tekst:’CAD’ 
 

Uitwerking: Tik in single line text → specificeer startpunt: toets in J(ustify) → 
geef optie : F(it) → specificeer willekeurig beginpunt   → tweede punt van 
tekst basislijn: @100,0 → specificeer teksthoogte: 50→ specificeer tekst:CAD  

3. Breng met het lettertype ‘RomanT’ en een letterhoogte van 5, in een kader 
van 100 breed, de volgende alineatekst aan: 

‘Alinetekst toevoegen aan een tekening is alleen zinvol als het om relatief 
veel tekst gaat, die een speciale opmaak vereist’. 

Uitwerking: Tik in Multiline text→ specificeer beginpunt van tekstkader → 
selecteer breedte:W(idth) → specificeer breedte: 100   → venster ‘Multiline text 
editor verschijnt → Selecteer lettertype ‘RomanT’→  wijzig letterhoogte in 5→ 
voer de tekst in 
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5. Bewerkingscommando’s 
Een stuk uit een tekenelement breken, een lijn afknippen of juist verlengen, zijn 
handelingen die vaak voorkomen bij het maken van een technische tekening. Het 
is dan ook van belang dat je deze handelingen juist kunt uitvoeren. 

5.1.  Selecteren van objecten 
Veel commando's komen op de proppen met de vraag select objects. De 
antwoorden op die vraag tref je hier aan. 

Acad blijft vragen om objecten op de commandoregel tot een lege 
<enter>gegeven wordt (muis of toetsenbord) 

Meest gebruikt is Toevoegen. Permanent door iets te selecteren met SHIFT 
ingedrukt (~de windows manier dus).  

5.1.1. U 

Undo. Twee gevallen. 

1. Command: Undo. 

De objecten van het laatste commando worden in zijn geheel geselecteerd, en dat 
kunnen een groot aantal lijnstukken zijn indien het om een line commando gaat. 

2. Specify next point or [Undo]:U 

Hier gaat het slechts om een element dat wordt weggehaald uit de selectieset. 

5.1.2. All display 

Hiermee kun je alles selecteren in het tekenvel 

5.1.3. Window, crossing selectie: 

2 punten nodig. niet slepen maar punt 1 aanklikken (en loslaten) en punt 2 
aanklikken (en uiteraard ook weer loslaten). 

• Van links naar rechts is Window selectie (alles wat in het venster valt).  
• Van rechts naar links is Crossing selectie (alles wat in het venster valt + alles 

wat er doorheen steekt).  
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5.1.4. L 

Last, hiermee selecteer je het laatst getekende. 

5.1.5. P 

Previous, hiermee selecteer alle elementen die je de vorige keer hebt 
geselecteerd.  

5.2. Break 
Niet alleen lijnen, maar ook cirkels, bogen en ellipsen kunnen gebroken worden. 

Oefening 

Teken de figuur hiernaast  

1. Tik in break 
2. Selecteer P1 (object wat gebroken moet worden) 
3. Specify second break point or[First point]:F (eerst willen het eerste breekpunt 

selecteren) 
4. Selecteer P2 (eerste breekpunt) 
5. Selecteer P3 (tweede breekpunt) 

Altijd linksom werken 

Verwijder nu in dezelfde figuur het gedeelte tussen P4 en P5 
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5.3. Lengthen 
Hiermee kun je objecten verlengen c.q inkorten. 

Oefening 

Verleng de horizontale en verticale lijnen zodanig dat deze ter plaatse van P2, P3, 
P4 en P5 5 eenheden buiten de cirkel uitsteken 

 

1. Tik in lengthen 
2. Select an object or [Delta/ Percent/ Total/ Dynamic]:DE (Delta zorgt voor toe-/ 

afname in eenheden, percent zorgt voor toe-/ afname in procent, bij total kan 
de totale lengte worden opgegeven, bij dynamic kan het object gesleept 
worden. 

3. Specify delta length:5 
4. Selecteer de rechte lijn bij P2 
5. Selecteer de rechte lijn bij P3 
6. Selecteer de rechte lijn bij P4 
7. Selecteer de rechte lijn bij P5 

5.4. Trim 
Hiermee kun je objecten inkorten, en wel exact tot aan een rand die 
gedefenieerd wordt door een ander tekenobject. 
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Oefening  

Kort met het trim commando de twee verticale lijnen in. 

 

1. Tik in trim 
2. Selecteer de rechte lijn bij P1 (selectie van de snijlijn) 
3. Select objects:<enter> (beeindiging selectie procedure) 
4. Select objects to trim: selecteer P2 (afknippen lijn) 
5. Select objects to trim: selecteer P3 (afknippen lijn) 
6. Select objects to trim: <enter> 

Verwijder alle overtollige lijnen zodat een rechthoek ontstaat 

5.5. Extend  
Hiermee kun je objecten verlengen, en wel exact tot aan een rand die 
gedefenieerd wordt door een ander tekenobject. 

Oefening: Verleng met het extend commando de bovenste horizontale lijn in. 

 



WERKTUIGBOUWKUNDE               
 

 
November 2004 Ing. A. M. Plein  - 22 - 

1. Tik in extend 
2. Selecteer de rechte lijn bij P1 (selectie van de rand) 
3. Selecteer de rechte lijn bij P2 (selectie van de rand) 
4. Select objects:<enter> (beeindiging selectie procedure) 
5. Select objects to extend: selecteer P3 (afknippen lijn) 
6. Select objects to extend: selecteer P4 (afknippen lijn) 
7. Select objects to extend: <enter> 

Maak van deze figuur een rechthoek met het trim en extend commando. 

6. Wijzigingscommando’s 
Het kan tijdens het tekenen voorkomen dat een onderdeel verschoven, gekopieerd, 
onder een andere hoek, verschaald, gespiegeld of uitgetrokken moet worden. Om 
dit soort aanpassingen snel te maken is Autocad voorzien van een aantal 
wijzigingscommando’s. 

6.1. Move 
Met het commando move kunnen we een onderdeel of meerdere onderdelen over 
het tekenveld verplaatsen. De verplaatsingsafstand en de verplaatsingsrichting 
wordt bepaald door het verschil tussen twee punten, de base point (basispunt) en 
het second point of displacement (verplaatsingspunt).  

De twee punten kunnen als volgt worden ingevoerd: 

1. Door het selecteren van beide punten in het tekenveld 
2. Door het selecteren van bestaande elementen d.m.v. de vangfuncties. Het is 

bijvoorbeeld mogelijk om een hoekpunt van een element exact tegen het 
hoekpunt van een ander element te plaatsen 

3. Door het invoeren van coordinaten (evt. polair of relatief (met het @-teken)). 
In dit geval doet het er niet toe waar het base point wordt gekozen, als het 
second point maar op de juiste afstand en in de juiste richting wordt 
ingevoerd. 

Oefening: Verplaats de cirkel van P1 naar P2. 

 

1. Tik in move 
2. Selecteer de cirkel 
3. Select objects:<enter> (beeindiging selectie 

procedure) 
4. Activeer de vangfuncties 
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5. Selecteren van de base point: beweeg de cursor op de omtrek van de cirkel 
tot het ‘Center’ symbool oplicht (een rondje in het hart van de cirkel – punt 
P1) en klik met je muisknop 

6. Selecteren van de second point: Plaats de cursor op de verticale lijn tot het 
‘endpoint’ symbool oplicht (punt P2) en klik met je muisknop.  

7. <enter> 

6.2. Copy 
Het commando copy werkt vrijwel hetzelfde als het commando move. Het verschil 
is echter dat er nu een kopie van de elementen wordt bijgemaakt. Een ander 
verschil is dat het mogelijk is de elementen meerdere malen te copieren. 

Oefening 

Copieer de cirkel naar het punt P2, P3 en P4. 

1. Tik in copy 
2. Selecteer de cirkel 
3. Voer in een M (van Multiple) om de cirkel 

meerdere keren te copieren 
4. Select objects:<enter> (beeindiging selectie 

procedure) 
5. Activeer de vangfuncties 
6. Selecteren van de base point: beweeg de 

cursor op de omtrek van de cirkel tot het 
‘Center’ symbool oplicht (punt P1) en klik 
met je muisknop 

7. Selecteren van de second point: Plaats de cursor op het kruispunt van de 
twee lijnen tot het ‘intersection’ symbool oplicht (punt P2) en klik met je 
muisknop.  

8. Selecteren van de second point: Plaats de cursor op het kruispunt van de 
twee lijnen tot het ‘intersection’ symbool oplicht (punt P3) en klik met je 
muisknop. 

9. Selecteren van de second point: Plaats de cursor op het kruispunt van de 
twee lijnen tot het ‘intersection’ symbool oplicht (punt P4) en klik met je 
muisknop. 

10. <enter> 

 

 

 



WERKTUIGBOUWKUNDE               
 

 
November 2004 Ing. A. M. Plein  - 24 - 

 

6.3. Mirror 
Als een deel van de tekening symmetrisch van opbouw is, dan kunnen we volstaan 
met het tekenen van de helft. De andere helft kunnen we dan spiegelen met 
behulp van het mirror commando, om een spiegelas. 

Het originele object kan gewist worden of blijven staan. 

Oefening: Teken een cirkel en een lijn. Spiegel de cirkel waarbij de lijn als 
spiegelas dient.   

1. Teken de cirkel en de lijn 
2. Tik in mirror 
3. Selecteer de cirkel 
4. Select objects:<enter> (beeindiging selectie procedure) 
5. Activeer de vangfuncties  
6. Selecteren van het eerste punt van de spiegelas: Plaats de cursor op de ene 

kant van de lijn tot het ‘endpoint’ symbool oplicht en klik met je muisknop 
7. Selecteren van het tweede punt van de spiegelas: Plaats de cursor op de 

andere kant van de lijn tot het ‘endpoint’ symbool oplicht en klik met je 
muisknop 

8. Verwijderen bron object [Yes/ No]<N>: Y  
9. <enter> 

6.4. Offset 
Met het offset commando kunnen we parallel kopieren. Bij dit commando moet 
worden aangegeven op welke afstand een tweede element getekend moet worden 
en aan welke zijde dat element geplaatst moet worden. 

Met de optie T(hrough) wordt voor het selecteren niet om een afstand gevraagd. Er 
wordt gevraagd om een punt te selecteren, waardoor het gekopieerde element zal 
worden geplaatst. 

Oefening: Neem de onderstaande figuur over en voer een offset op een afstand 
van 5 uit.  

1. Teken de lijn, cirkel en lijn 
2. Tik in offset 
3. Specify offset distance or 

[Through] <Through>: 5 
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4. Select object to offset or  exit:selecteer de lijn (P1) 
5. Wijs aan aan welke kant de offset moet plaatsvinden: klik punt P2 
6. Select object to offset or exit:selecteer de cirkel(P3) 
7. Wijs aan aan welke kant de offset moet plaatsvinden: klik punt P4 
8. Select object to offset or exit:selecteer de lijn (P5) 
9. Wijs aan aan welke kant de offset moet plaatsvinden: klik punt P6 
10. <enter>  

Oefening: Neem de onderstaande figuur over en offset de verticale lijn door het 
eindpunt van de horizontale lijn.  

1. Tik in offset 
2. Specify offset distance or 

[Through] <Through>: T 
3. Select object to offset or 

exit:selecteer de verticale lijn (P1) 
4. Activeer de vangfuncties 
5. Specify through point : Plaats de 

cursor op de horizontale de lijn tot 
het ‘endpoint’ symbool oplicht en 
klik met je muisknop. 

6. <enter>  

6.5. Rotate 
Het commando rotate stelt ons in staat om onderdelen van een tekening te laten 
roteren om een punt. De rotatie is tegen de wijzers van de klok in, als we een 
positieve waarde van de rotatiehoek opgeven. 

De optie R(eference) stelt ons in staat om onderdelen van een tekening te laten 
roteren om een punt waarbij de hoek onbekend is.   

Oefening: Roteer de cirkel over een hoek van +38 graden 

1. Tik in rotate 
2. Selecteer de cirkel 
3. Select objects:<enter> 

(beeindiging selectie procedure) 
4. Activeer de vangfuncties  
5. Selecteren van de base point: 

Plaats de cursor op de onderste 
lijn tot het ‘endpoint’ symbool 
oplicht (punt P1) en klik met je 
muisknop.  

6. Voer in de gewenste hoek.  
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7. <enter> 

Oefening: Roteer de cirkel over een hoek die ligt tussen twee lijnen 

1. Tik in rotate 
2. Selecteer de cirkel 
3. Select objects:<enter> (beeindiging 

selectie procedure) 
4. Activeer de vangfuncties  
5. Selecteren van de base point: Plaats 

de cursor op de onderste lijn tot het 
‘endpoint’ symbool oplicht (punt P1) 
en klik met je muisknop.  

6. Specificeer hoek of [Reference]:R 
(optie reference selecteren) 

7. Specificeer hoek:  Plaats de cursor op de onderste lijn tot het ‘endpoint’ 
symbool oplicht (punt P1) en klik met je muisknop 

8. Specificeer tweede punt: Plaats de cursor op de andere kant van de onderste 
lijn tot het ‘endpoint’ symbool oplicht (punt P2) en klik met je muisknop 

9. Specificeer de nieuwe hoek: Plaats de cursor op de bovenste lijn tot het 
‘endpoint’ symbool oplicht (punt P3) en klik met je muisknop 

10.  <enter> 

 

6.6. Scale 
Als blijkt dat een onderdeel te groot of te klein is getekend, dan kunnen we met 
het scale commando dit onderdeel dusdanig verschalen dat het wel de gewenste 
afmetingen verkrijgt. Bij een vergroting moet een schaalfactor >1 worden 
ingevoerd, bij een verkleining <1. 

De optie R(eference) stelt ons in staat om onderdelen van een tekening te 
verschalen waarbij de schaalfactor onbekend is.  

Oefening: Teken een cirkel met radius 50 en maak daarna deze cirkel 2x zo groot.  

1. Teken de cirkel 
2. Tik in scale 
3. Selecteer de cirkel 
4. Select objects:<enter> (beeindiging selectie procedure) 
5. Activeer de vangfuncties  
6. Selecteren van de base point: Beweeg de cursor op de omtrek van de cirkel 

tot het ‘Center’ symbool oplicht en klik met je muisknop. 
7. Voer in de gewenste schaalfactor.  
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8. <enter> 

Oefening: Teken een cirkel met r=50, verschaal deze cirkel waarbij de schaalfactor 
wordt bepaald door de verhouding van de lengte van de lijnen P1-P2 en P1-P3 

1. Tik in scale 
2. Selecteer de cirkel 
3. Select objects:<enter> (beeindiging selectie 

procedure) 
4. Activeer de vangfuncties  
5. Selecteren van de base point: Plaats de 

cursor op de cirkel tot het ‘center’ symbool 
oplicht (punt P1) en klik met je muisknop.  

6. Specificeer hoek of [Reference]:R (optie 
reference selecteren) 

7. Specificeer referentie lengte:  Plaats de 
cursor op de horizontale lijn tot het ‘endpoint’ symbool oplicht (punt P1) en 
klik met je muisknop 

8. Specificeer tweede punt: Plaats de cursor op de andere kant van de 
horizontale lijn tot het ‘endpoint’ symbool oplicht (punt P2) en klik met je 
muisknop 

9. Specificeer de nieuwe lengte: Plaats de cursor op de verticale lijn tot het 
‘endpoint’ symbool oplicht (punt P3) en klik met je muisknop 

10.  <enter> 

 

6.7. Stretch 
Het commando stretch biedt de mogelijkheid een geselecteerd deel van de 
tekening uit te rekken, waarbij verbindingen van de verplaatste objecten op hun 
plaats blijven. Voor het selecteren van de uit te rekken elementen dient men 
crossing te gebruiken.  

Oefening: Teken een vierkant en rek daarna dit vierkant uit tot het een rechthoek 
wordt met zijden die 2x zo lang zijn.  

1. Teken het vierkant 
2. Tik in stretch 
3. Selecteer de uit te rekken elementen m.b.v. een crossing  
4. Select objects:<enter> (beeindiging selectie procedure) 
5. Activeer de vangfuncties  
6. Selecteren van de base point: Plaats de cursor op een lijn tot het ‘endpoint’ 

symbool oplicht en klik met je muisknop  
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7. Specify second point of displacement : Plaats de cursor op dezelfde lijn maar 
dan aan de ander kant tot het ‘endpoint’ symbool oplicht en klik met je 
muisknop  

8. <enter> 

6.8. Array 
Het commando array maakt het mogelijk om een object(en) meerdere malen te 
kopieren volgens een rechthoekig patroon of een cirkelvormig patroon. 

Oefening: teken een cirkel en kopieer de cirkel volgens een rechthoekig patroon 
wat bestaat uit twee rijen en vier kolommen. De afstand tussen de rijen is 5, de 
afstand tussen de kolommen is 8 

1. Teken de cirkel 
2. Tik in array 
3. Selecteer het te kopieren object(en) 
4. Select objects:<enter> (beeindiging selectie procedure) 
5. Enter the type of array [rectangular/ Polar] <R>: R (rechthoekig patroon) 
6. Enter the number of rows: 2 
7. Enter the number of colums: 4 
8. Enter the distance between rows: 5 
9. Enter the distance between colums: 8 
10. <enter> 

Oefening: Teken een driehoek. Kopieer de driehoek 8x om het punt (0,0) volgens 
een cirkelvormig patroon over 360 graden.  

1. Teken een driehoek met coordinaten (50,50), (100,50), (75, 100)  
2. Tik in array 
3. Selecteer het te kopieren object(en) 
4. Select objects:<enter> (beeindiging selectie procedure) 
5. Enter the type of array [rectangular/ Polar] <R>: P (cirkelvormig patroon) 
6. Specify center point of array:tik in (0,0)  
7. Enter the number of tems in the array: 8 
8. Specify the angle to fill <360>: enter 
9. Rotate objects: [Yes/ No]<N>: Y 
10. <enter> 
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6.9. Fillet 
Het fillet commando verbindt twee lijnen met elkaar. De radius voor de 
verbindingslijn is instelbaar. Bij een radius van 0 worden de twee lijnen verlengd 
tot ze elkaar snijden.  

Oefening: Teken deze drie lijnen en maak eerst afrondingen met een radius van 0 
en daarna met een radius van 2  

1. Teken de lijnen 
2. Tik in fillet 
3. Current settings: Mode=Trim, Radius=0 

(huidige default waarden)             
Select first object or [Polyline, Radius, 
Trim]: R (specificeer de radius).  

4. Specificeer fillet radius <0>: 0 
5. <enter>: om het commando te herhalen 
6. Selecteer eerste object: selecteer lijn 
7. Selecteer tweede object: selecteer 

andere lijn 
8. enz.  

Oefening: Teken twee lijnen die loodrecht op elkaar staan en maak een afronding 
met een radius van 4 waarbij de afgeronde objecten niet worden ingekort.   

1. Teken de twee lijnen 
2. Tik in fillet 
3. Current settings: Mode=Trim, Radius=2 (huidige default waarden)        

Select first object or [Polyline, Radius, Trim]: R (specificeer de radius).  
4. Specificeer fillet radius <2>: 4 
5. <enter>: om het commando te herhalen 
6. Select first object or [Polyline, Radius, Trim]: T (specificeer de trim optie 
7. Specificeer trim optie [Trim/ No trim]<trim>:N 
8. Selecteer eerste object: selecteer lijn 
9. Selecteer tweede object: selecteer andere lijn 
10. <enter>  

Oefening: Teken twee evenwijdige lijnen en maak een afronding   

1. Teken de twee lijnen 
2. Tik in fillet (niet nodig om fillet radius op te geven) 
3. Selecteer eerste object: selecteer lijn 
4. Selecteer tweede object: selecteer andere lijn 
5. <enter>  
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6.10. Chamfer 
Het fillet chamfer kort twee lijnen over een bepaalde afstand in en plaatst tussen 
deze twee eindpunten een nieuwe lijn (afkanten). Per lijn kan een afkort afstand 
opgegeven worden.  

Oefening: Teken twee lijnen die loodrecht staan op elkaar en kant de eerste lijn 
over een afstand van 2 af en de tweede lijn over een afstand van 4.   

1. Teken de twee lijnen 
2. Tik in chamfer 
3. Current settings: Trimmode Current chamfer Dist 1=0, Dist2=0 (huidige 

default waarden)                                                                                 
Select first object or [Polyline/ Distance/ Angle, Trim/ Method]: D (specificeer 
de afstand).  

4. Specificeer eerste chamfer afstand <0>: 2 
5. Specificeer tweede chamfer afstand <0>: 4 
6. <enter>: om het commando te herhalen 
7. Select first object or [Polyline/ Distance/ Angle, Trim/ Method]: selecteer 

eerste lijn 
8. Selecteer tweede object: selecteer andere lijn 
9. <enter>  

7. Lagen 
Binnen Autocad kan gebruik worden gemaakt van Layers, ook wel (teken)lagen 
genoemd. Een laag kan worden voorgesteld als een doorzichtig laagje folie waarop 
een deel van de tekening staat. Worden alle lagen folie op elkaar gelegd, dan is de 
totale tekening zichtbaar. Het is bijvoorbeeld mogelijk om op een laag alle 
begrenzingslijnen te plaatsen, terwijl in een ander laag alle niet zichtbare 
begrenzingslijnen zijn ondergebracht. 

7.1. Laagindelingen  
Hieronder volgt een voorbeeld van een lagenindeling voor een 
werktuigbouwkundige tekening. 

Laagnaam Kleur Lijntype Lijndikte 
0 Wit Doorlopend  (Continous) default 
Arcering Grijs Doorlopend (Continous) 0,25 
Bemating MagentaDoorlopend (Continous) 0,25 
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Dunnelijn Groen Doorlopend (Continous) 0,25 
Kader+titelblok Wit Doorlopend (Continous) 0,50 
Nietzichtbarelijn Cyan Streeplijn (Hidden) 0,50 
Symmetrielijn Rood Streepstip lijn (Center) 0,25 
Tekst Wit Doorlopend (Continous) 0,25 
Zichtbarelijn Wit Doorlopend  (Continous) 0,50 
Gebroken lijn Geel Gebroken (zig zag) default 

Bij het opstarten van autocad is een laag al aanwezig, namelijk laag 0.  

Oefening: Maak de lagen aan volgens de bovengenoemde laagindeling. Teken, 
in de juiste layer, de onderstaande tekening (zonder bemating). 

Uitwerking 

1. Start een nieuwe tekening 
2. Laden van lijntypen 

a. Tik in linetype 
b. Klik op load 
c. Selecteer de lijnsoort ‘Center(=symmetrielijn)’, houd de ctrl toets 

ingedrukt en selecteer ‘Hidden(=nietzichtbarelijn)’. De lijnsoort 
‘Continuous (=zichtbarelijn)’ is standaard voorgeselecteerd 

d. Klik op ‘OK’ (beide lijnsoorten verschijnen nieuw in het venster)  
e. Klik op ‘OK’ (om te bevestigen) 

3. Aanmaken van een nieuwe laagnaam 
a. Tik in layer 
b. Klik op ‘New’ 
c. Verander op de invoerstrook ’Layer1’ in ‘arcering’ en druk 

<enter> om te bevestigen 
d. Benoem zo alle laagnamen 

4. Koppelen van een bepaald lijntype aan een laag 
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a. Klik binnen het venster ‘Layer Properties Manager’ op het lijntype 
continuous van de tekenlaag ‘symmetrielijn’. Venster ‘Select 
Linetype’ verschijnt 

b. Selecteer het lijntype ‘Center’ 
c. Klik op ‘OK’ 
d. Venster ‘Layer Properties Manager’ verschijnt weer 
e. Koppel ook zo de lijntype ‘Hidden’ aan ‘nietzichtbarelijn’ 

5. Koppelen van een bepaalde kleur aan een laag 
a. Klik binnen het venster ‘Layer Properties Manager’ op de kleur 

white van de tekenlaag ‘arcering’. Venster ‘Select color’ 
verschijnt 

b. Selecteer de kleur grijs 
c. Klik op ‘OK’ 
d. Venster ‘Layer Properties Manager’ verschijnt weer 
e. Koppel ook zo de andere kleuren 

6. Koppelen van een bepaalde lijndikte aan een laag 
a. Klik binnen het venster ‘Layer Properties Manager’ op de ‘default 

lineweight’ van de tekenlaag ‘symmetrielijn’. Venster ‘Lineweight’ 
verschijnt 

b. Selecteer de lijndikte 0,25 
c. Klik op ‘OK’ 
d. Venster ‘Layer Properties Manager’ verschijnt weer 
e. Koppel ook zo de andere lijndikten 

7. Beginnen met tekenen.  
a. Selecteer in de toolbar ‘Object Properties’ de laag ‘zichtbarelijn’ 

en teken alle zichtbare lijnen, inclusief afrondingen en 
afschuiningen in deze laag 

b. Selecteer in de toolbar ‘Object properties’ de laag ‘symmetrielijn’ 
en teken alle symmetrielijnen in deze laag 

c. Selecteer in de toolbar ‘Object properties’ de laag ‘nietzichtbare’ 
en teken alle niet zichtbare lijnen in deze laag 

d. Selecteer in de toolbar ‘Object properties’ de laag ‘tekst’ en teken 
alle tekst in deze laag 

De tekening is nu opgebouwd volgens een bepaalde laagindeling. Bepaalde lagen 
kan je ‘Uit’ of ‘Op slot’ doen. Indien je layer intikt op de commandoregel verschijnt 
het venster ‘Layer Properties Manager’. Als je klikt op het lampje van bijv. de laag 
‘symmetrielijn’, dan zal je zien dat bij het verlaten van het venster, de laag 
‘symmetrielijn’ verdwenen is. Dit kan een tekening overzichtelijk maken. 

Naast bijvoorbeeld het lijntype ‘Center’ komen ook de lijntypen ‘Center2’ en 
Centerx2’ voor. Deze lijntypen zijn qua vorm gelijk, echter de fijnheid van deze 
lijnen verschilt. De mate van grof of fijn is te beinvloeden met behulp van de 
variabele ‘Linetype Scale’. Hoe kleiner de waarde, hoe fijner de lijn. Indien een 
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onderbroken lijn niet te onderscheiden is van een doorgetrokken lijn, dan kan het 
verhogen of verlagen van de waarde van de linetype scale vaak een oplossing zijn. 

Met de standaardinstelling LWT (=lineweight) midden onderin je scherm kun je 
grafisch de lijndikten in je tekening weergeven. De LWT kan aan- of uitgemaakt 
worden. 
 
Het is zinvol om een nieuwe tekening te maken waarin alleen maar een 
lagenindeling is gemaakt en waar verder niks instaat. Deze tekening kunnen we 
steeds gaan gebruiken bij het maken van een nieuwe opdracht. De tekening kan 
als naam krijgen ‘Format’.  

7.2. Laagindelingen wijzigen 
Het is mogelijk om wijzigingen aan te brengen in een tekening, via het commando 
properties. Wijzigingen kunnen o.a. zijn het verplaatsen van objecten van de ene 
laag naar de andere laag. 

Oefening:  Verplaatsen van een object uit de laag ‘zichtbarelijn’ naar de laag 
‘nietzichtbarelijn’. 

Uitwerking: 

a. Tik in properties 
b. Venster ‘Properties’ verschijnt 
c. Selecteer het object uit de laag ‘zichtbarelijn’ 
d. Wijzig in het ‘Properties’ venster de layer ‘zichtbarelijn’ in 

‘nietzichtbarelijn’ en druk <enter> om te bevestigen 
e. Klik op het kruis in de rechter bovenhoek van het ‘Properties’ 

venster om het ‘Properties’ venster af te sluiten 

8. Arceren 
Arceren is een volledig omsloten gebied opvullen met een bepaald arceerpatroon. 
Doorsneden in technische tekeningen worden meestal gearceerd en het heeft de 
voorkeur deze arcering in een aparte tekenlaag te plaatsen. 

8.1. BHATCH 
Bij het commando BHATCH maak je gebruik van standaard arceerpatronen. De 
omtrek van het te arceren gebied wordt automatisch bepaald door een punt op te 
geven binnen dat gebied. Eilanden binnen het te arceren gebied, die geen deel 
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uitmaken van de omtrek, worden niet mee gearceerd. Indien de begrenzing 
verandert, dan past de arcering zich hierop aan. 

Oefening:  Teken de onderstaande tekening (zonder bemating). En breng in het 
onderste vlak van de voordeur een arcering aan in de daarvoor 
bestemde tekenlaag. Het arceerpatroon is ‘angle’ en de schaal van 
deze arcering is 2. 

 

Uitwerking 

1. Teken de voordeur 
2. Tik in bhatch 
3. Venster Boundary Hatch 

verschijnt 
4. Selecteer het patroon (pattern): 

Klik op het rechthoekje met drie 
stippen. Er verschijnt een 
venster ‘Hatch pattern palette’, 
klik op ‘ANSI’ en selecteer 
‘ANSI31’ als arceer patroon. 

5. Zet de schaalwaarde op :10 
6. Klik op:’pick points’ (je bent 

weer terug in de tekening) 
7. Select internal point: selecteer 

P1 (de omtreklijnen lichten op) 
8. Druk op enter (je bent weer 

terug in Venster ‘Boundary 
Hatch’)  

9. Klik op ‘preview’ (staat de 
arcering je aan) 

10. Druk op enter 
11. Klik op OK 

Oefening:  Zoom in op de brievenbus en breng hierop een arcering aan met het 
patroon ‘dots’, de arceerschaal is 20. 

 
Opmerking: je ziet dat de tekst vrij blijft van het arceerpatroon 

 
Oefening:  Breng in het bovenste vlak van de voordeur een arcering aan, het 

arceerpatroon is ‘ANSI31’, de arceerschaal is 20. 
 

900 

2015 
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Opmerking: je ziet dat het ronde doorkijkvenster vrij blijft van het 
arceerpatroon 

 
Oefening:  Verplaats het ronde doorkijkvenster van de voordeur 200 eenheden 

naar beneden m.b.v. het move commando. De arcering mag niet 
gewist worden. 

 
Opmerking: de arcering past zich aan na een wijziging in de 
begrenzing. 

 
Algemeen: -   Arceringen worden als een geheel geplaatst, en niet als een serie  

afzonderlijke lijntjes 
- Plaats de arcering in een aparte tekenlaag 
- Zet de tekenlaag die nietzichtbare lijnen bevat bij het arceren ‘Uit’. 

Deze niet zichtbare lijnen kunnen een belemmering zijn bij het 
arceren 

- Zorg ervoor dat het arceergebied geen ‘gaten’ vertoont in de 
omtrekslijn.  

 
 

9. Bemating 
 
Oefening: teken de onderstaande figuur en plaats alle maten. 
 
 

Uitwerking: 
1. Tik in dimlinear 
2. Specify first extension line origin or 

<select objects>: selecteer P1 
(maataanhaallijn eerste oorsprong)  

3. Specify second extension line origin 
or <select objects>: selecteer P2 
(maataanhaallijn tweede oorsprong)  

4. Specify dimension location or [Mtext/ 
text/ Angle/ Horizontal/ Vertical/ 
Rotated]:selecteer de plaats van de 
maatlijn 

5. <enter> 
6. Plaats nu de overige maten 
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Oefening: teken de onderstaande figuur en plaats alle maten. 
 

 
 
Werkwijze van het plaatsen van de hartlijn 
1. Tik in dimcenter 
2. Select arc or circle: selecteer de omtrek van de 

cirkel 
3. <enter> 

 
 
 
 

 
Indien de hartlijn te klein uitvalt, gebruik: 
- commando extend om te verlengen 
- Selecteer op de menubar: Format → Dimension style → Modify  en bij 
Centermarks for circles  vergroot je de size  

 
Werkwijze van het plaatsen van de maat 50 

1. Tik in dimlinear 
2. Specify first extension line origin or <select objects>: <enter> 
3. select object to dimension: selecteer P1  
4. Specify dimension location or [Mtext/ text/ Angle/ Horizontal/ Vertical/ 

Rotated]: selecteer de plaats van de maatlijn 
5. <enter> 

 
Oefening: teken de onderstaande figuur en plaats alle maten. 

 
Werkwijze van het plaatsen van de maat 70 

1. Tik in dimaligned 
2. Specify first extension line origin or 

<select objects>: selecteer P1  
3. Specify second extension line origin 

or: selecteer P2 
4. Specify dimension location or [Mtext/ 

text/ Angle/ Horizontal/ Vertical/ 
Rotated]: selecteer de plaats van de 
maatlijn 

5. <enter> 
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Werkwijze van het plaatsen van de hoekmaat 300 

1. Teken de horizontale dunne lijn vanuit P1 
2. Tik in dimangular 
3. Select arc, circle, line: selecteer dunne lijn vanuit P1  
4. Select second line: selecteer lijn onder 300 
5. Specify dimension arc line: Specifeer lokatie van de hoekmaat  

 
Werkwijze om de tekst van de hoekmaat van 300 horizontaal te plaatsen 

1. Commando: Modify → Properties 
2. Selecteer dimensie 
3. Selecteer het “+” teken voor de optie Fit 
4. Bij text movement: verander de waarde naar move text, add leader 
5. Vervolgens selecteer je de waarde van de hoekmaat en verplaats je het 

zodanig dat de waarde van de hoekmaat horizontaal wordt geplaatst. 

Opmerking 

Onder Modify → Properties kun je ook de waarde van de bijbehorende tolerantie 
invoeren, selecteer het “+” teken voor de optie Tolerances en verander waar nodig 

10. Blocks 
 
Een BLOCK is een verzameling van een aantal objecten, zoals bijvoorbeeld lijnen, 
bogen etc, die zijn samengevoegd tot een geheel. Dit geheel kan als een block 
worden ingevoegd in de tekening. Het werken met blocks kan het maken van een 
tekening versnellen, omdat steeds terugkerende tekenhandelingen nu overbodig 
zijn geworden. Je kunt met blocks een bibliotheek van onderdelen samenstellen.  
 
Er zijn twee soorten blocks.  
BLOCK:  Een BLOCK, aangemaakt binnen de tekening met Draw → Make → 

Block, kun je alleen in dezelfde tekening oproepen. Met BLOCK kun je 
een interne bibliotheek binnen de tekening samenstellen. 

WBLOCK: Een WBLOCK kun je in iedere willekeurige tekening oproepen met 
Insert →  Block. Een WBLOCK wordt gesaved op bijvoorbeeld je harde 
schijf. Een WBLOCK is dus een tekening die je kunt oproepen in een 
andere tekening. Met WBLOCK kun je een externe bibliotheek 
samenstellen. 

 
Werkwijze aanmaken BLOCK ‘vierkant’ 

• Teken een vierkant op je scherm 
• Tik in block 
• Voer de naam ‘vierkant’ in van het block 
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• Bepaal het base point (referentiepunt). Neem als base point een hoekpunt 
van het block ‘vierkant’.  

• Selecteer de elementen van het block ‘vierkant’ op het scherm. 
• Het vierkant is nu omgezet in een block. 

 
Werkwijze invoegen BLOCK ‘vierkant’ 

• Tik in insert 
• Selecteer het gewenste block ‘vierkant’.  
• Selecteer de optie onder ‘insertion point’, scale en rotation: specify on 

screen, de optie  en klik ok. Je kunt nu de kruisdraden over het scherm 
verplaatsen en zien dat het block ‘vierkant’ aan de kruisdraad hangt.  Je kunt 
ook de schaalfactor in de x en y-richting invoeren en de rotatiehoek. 

 
Werkwijze aanmaken WBLOCK ‘cirkel’ 

• Teken een cirkel op je scherm 
• Tik in wblock 
• Voer de naam ‘cirkel’ in van het wblock en geef ook de lokatie aan waar het 

tekeningetje dat je saved, later opgeroepen kan worden.  
• Bepaal het base point (referentiepunt). Neem als base point het middelpunt 

van de cirkel.  
• Selecteer de cirkel op het scherm. 
• De cirkel is nu als wblock gesaved als cirkel.dwg. 

 
Werkwijze invoegen WBLOCK ‘cirkel’ 

• Start een nieuwe tekening 
• Tik in insert 
• Selecteer het gewenste block ‘cirkel’ door gebruik te maken van de browse 

optie en de file cirkel.dwg te selecteren .  
• Selecteer de optie onder ‘insertion point’, scale en rotation: specify on 

screen, de optie  en klik ok. Je kunt nu de kruisdraden over het scherm 
verplaatsen en zien dat het block ‘vierkant’ aan de kruisdraad hangt.  Je kunt 
ook de schaalfactor in de x en y-richting invoeren en de rotatiehoek. 

 
Aandachtspunten 

• Een block en een wblock worden opgeslagen als een object, wat als voordeel 
heeft dat het minder geheugenruimte in beslag neemt als alle afzonderlijke 
objecten bij elkaar. 

• Alleen als een block wordt ingevoegd op laag 0 neemt het de eigenschappen 
(kleur, lijntype) aan van laag 0. Bij invoer op andere lagen behoudt het block 
zijn oorspronkelijke eigenschappen. 

• Met het commando explode kun je een block weer omzetten in afzonderlijke 
objecten.  

 


	Introduktie AutoCad (2D)
	Inleiding
	Inhoud
	Introduktie AutoCad (2D)
	1. Starten met AutoCad
	1.1. Het scherm
	1.2. Een nieuwe tekening beginnen
	1.2.1. Tekengrenzen (Drawing Limits)
	1.2.2. Teken eenheden (Drawing Units)

	1.3. Toolbars
	1.4. Commandovenster
	1.5. Muis functies
	1.6. Je eerste pennestreek
	1.7. Erase
	1.8. Coordinaten opgeven

	2. Basics...
	2.1. Tekenhulpen
	2.1.1. Het Helpmenu
	2.1.2. SNAP en GRID
	2.1.3. ORTHO

	2.2. Vangfuncties (OSNAP)
	2.2.1. Snap to Endpoint
	2.2.2. Snap to Midpoint
	2.2.3. Snap to Intersection
	2.2.4. Snap to Center
	2.2.5. Snap to Tangent
	2.2.6. Snap to Perpendicular

	2.3. Zoom commando's
	2.3.1. Zoom In
	2.3.2. Zoom In out
	2.3.3. Zoom Window
	2.3.4. Zoom Previous
	2.3.5. Zoom Extents
	2.3.6. Zoom All
	2.3.7. Zoom Realtime


	3. Tekenen van elementen
	3.1. Line: L;
	3.2. Circle: C;
	3.3. Arc: A
	3.4. Ellipse: EL
	3.5. Polygon: POL;

	4. Tekst
	5. Bewerkingscommando’s
	5.1. Selecteren van objecten
	5.1.1. U
	5.1.2. All display
	5.1.3. Window, crossing selectie:
	5.1.4. L
	5.1.5. P

	5.2. Break
	5.3. Lengthen
	5.4. Trim
	5.5. Extend

	6. Wijzigingscommando’s
	6.1. Move
	6.2. Copy
	6.3. Mirror
	6.4. Offset
	6.5. Rotate
	6.6. Scale
	6.7. Stretch
	6.8. Array
	6.9. Fillet
	6.10. Chamfer

	7. Lagen
	7.1. Laagindelingen
	7.2. Laagindelingen wijzigen

	8. Arceren
	8.1. BHATCH

	9. Bemating
	10. Blocks

